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For at starte et nyt projekt vaelges:

File new project > File — New — Schematic.
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Funktionstaster genveje:

Curser position er nyt center F5
Grid on/off F6
Move F7
Split F8
Redo F10
Adder k £ >
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Scroll ned, vaelg component. 4077 Cuad XMOR
’ & p 4078 G-input NOR
4051 Cuad Z-inpuk ARD
4082 Dual 4-impuk ARD
4059 Binary rake MULTIPLIER
=} 4093 Quad Z-input MaND schmikt trigger
40930 5014
40930 :DIL14
4094 g-stage SHIFT)STORE REGISTER, &..
4095 Mon-inverting K master slave FLIP .
4096 Inverting gated JK master slave FL...
4097 Dual S-channel AMALDG MULTIPLES..
4098 Dual monoskable MULTIVIERATOR
4099 8-Bit addressable LATCH

Der vises detaljer omkring valgt
komponent.

Diagramsymbolet, og IC-pakken,
deeri.

Klik OK
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Quad 2-input MAMND schmitt trigoer

Package: DIL14

Dual In Line Package

Placer og klik T . Stop afslutter de igangverende funktioner.
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Flyt komponenter efter klik pa
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Komponenter kan manipuleres, Fx. Kopier med |ﬂ|, Roter |i|, Slet |£|

Fgr der tegnes forbindelser, - kaldet Net. Kan man ggre komponenternes forbindelser synlige.

Klik Display Layers . knappen. Layers:
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Ggr dem synlige. Tryk OK.
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Resultatet ser saledes ud: Nu kan man se tilledningerne.

Teg | - N _/|;|/' rr~— - 5 Miter: |F|P' Style:Nethass:DdeFault

;et' Ekstra valgmuligheder for Net-tegning.
vy Klik, der hvor net evt. skal knakke.

2 museklik pa same punkt, stopper bustegning.
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Plus og Nul — forbindelser kan nu pafgres.
Plus-forsyning ligger under folderen
”Supplyl” og ”Supply2”. Efter
forsyningen er pafgrt bliver der sat nogle
testpunkter da forsyningspunkterne kun er
en markering af banen der er forsyning.
Testpunkterne kan man satte nogle spyd i
til forsyning mm. ???
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For at tildele komponenter verdier, klikkes pa %QE, og der klikkes pa

en modstand.

—1 1 |+
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Tilsvarende vil |ﬂ|

give mulighed for at @ndre komponentnumre.

B Value

Mew value For R1:

x|

| 10K]

| ox

For instance, the ohmic value of a resistor is assigned by clicking the Value button, clicking on the
crosshair of the resistor, and entering the resistor value in the value field of the pop-up window.

Electrical Rule Check



Klik Electrical Rule Check = Herved fas en
liste over evt. manglende forbindelser.

Fx som vist her:

& ERC Errors

Type i

Sheet |

- Consistency not checked (no board loaded)

=+ Errors (1)

@ Unconnected INPUT pin IC1 DIS

- Warnings (5)

¢ () POWER pin IC1 V+ connected to +5V
'.'_?',' Part POWER has no value

(%) Part PWR has no value

") Part SPKR has no value

. L (1) Part SWITCH has no value
Appr_mred (0)

[~ centered Clear all

= e e

Processed Approve

Navne til Net, Baner:

Vha. at navngive ledninger, kan man skabe forbindelser mellem forskellige steder pa et diagram,
uden at der er tegnet en forbindelse. Ledninger ( Net ) med samme navn er forbundne. !!

Biblioteksoversigt:

Her er det ideen, med tiden at fa lavet en liste over "interessante” komponent-biblioteker.

RCL ?7?

modstande

kondensatorer

Loddespyd, conectorer osv.




Komponent Grupp

Resistorer rcl

Kondensatorer Capacitor-wima
rcl

Dioder diode

Lysdioder led

Spolar rcl

Likriktarbryggor |rectifier

Transistorer Transistor-npn
Transistor-pnp

Reldn relay

Potentiometrar | pot

74-kretsar (DIL) | 74xx-eu

Batterikontakten | Battery ABOV
Strombrytaren | Switch 9070-1W
Motstandet Rel 207/10
Lysdioderna Led LED5SMM
Bus: 7

En bus er en samling ledninger. Ledningerne adskilles med et ledningsnavn, ( Net-name )

Default navn pa en bus er B$1, men den skal
@ndres, sa man har styr pa, hvor mande del-
ledninger den bestar af.

En bus er kun et tegne-element. Den skaber
ingen elektriske forbindelser. De er altid skabt af
tegnede NET, og deres navne.

LD DISPLAN 16x2
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R
Brug ™ til at tildele et navn til en bus.

Eksempler pa navne:

Bus1:A[0..12]
Bus1:AJ0..12],Clock
Bus1:A[0..12],D[0..4],Clock

H Mame

Mew narne:

| 51 A[0.,12]

I (0].4

[=m

Ledninger forbindes til en bus, ved at velge at tegne net, og starte ledningen

pa en bus.

Nar der startes, abner en menu, hvorfra man kan valge en af elementerne (
ledningerne ) i bussen. Navnet pa nettet, som skal placeres, velges i menuen.

En menu abner sig, hvis der klikkes pa en bus med NET

Al
Al
Az
A3
A
A5
A
A7
AR
D
Al0
All
ALz

Her er der navngiver en bus med flere
“delbusser”

BUS 1:A[0.,12] D[0..7].CLOCK

A1l

A1

A2

RES

IR

Hgjreklik, med Net — @ndre vinkler pa bus-forbindelser.

Brug knappen | for at vise bus-navnet. Klik pa

bussen, og treek navnet ud.




Komponentliste:

Eagle kan automatisk generere en komponentliste:

File > Export > Parts.

Biblioteker:

ggres med kommandoen:

Hvis der ikke figurerer biblioteker, nar man gnsker at placere en komponent, skal de loades.

Velg gverst: Library / Use, og valg de gnskede biblioteker. Evt. tastes:

use * 1 komando-boksen.

Hvis man — evt. ved et uheld, kommer til at "Droppe” et bibliotek, betyder det ikke, at det er slettet.
Det er blot ikke inkluderet i “udvalgte biblioteker” leengere.

I Cow

Droppede biblioteker kan ses i
kontrolpanel, som et bibliotek, der ikke har
en grgn “lampe”

Klik pa den manglende lampe for at teende
den igen !
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Description
Libr aries

Libraries Far Electrical Schematics

3M Cannectors

7 Seqment Mumeric Displays
19-Inch Slok Eurocards

41w Series Devices

7o Series Devices

Advanced Micro Devices Flash Meme
Agilent Technologies

Allegro MicroSystems, Inc

ALPS Switch From Markus Faust <mf




Printudlaeg:

Nar der er tegnet diagram, kan man skifte til printudleegs-siden.

# 2 Board - C:\Program Files\EAGLE-5.3.0\projects\examples\tutorial\Ti ;Iglil
. . ° File Edit Draw View Tools Lbrary Optons Window Help
Velg: File Switch to board eller tryk pad. | |n gz |2 w =x aacag- - ©8| 2
| 5
o ool 3
Wy i
Maske spgrges om, der skal skabes en ny '33’ if
fil. By
£ S
Herefter fas en ny skaermside, med de fj(: :3
brugte komponenter, med elastikker &
mellem de ben, der skal have en ‘; ;
forbindelse. Py i
v 4 [r[
Til hgjre ses “’printpladen” | Z
@nsker man at tende grid, trykkes Grid v | NGO x|
knappen. ( findes pa toolbar.) Display Style
Klik pa On. |7F On " off L" Dots Lines
Size:  |0.05 finch =] Finest
Multiple: I 1
Al f0.025 finch =|  Finest
Default | Ok Cancel




SEHS110

Vha Move, |i| og Rotate, 1K flyttes

komponenterne op pa “printpladen.

Gummibandene fglger med !!.

Det er vigtigt, at der tjekkes for korrekt forbindelse. Jeg har fundet fejl i en komponent, en
SFHS5110!.

Andre til mm.
Tryk gverst til venstre pa GRID.

16 Botkom % _1
— II.Z? i (66,04 43, 18)
| - |"-f:} —

5 ¢ K/
. . . ER +
Kvik @&ndring af ops@tning: —— Class  *
9 Diameter  »
] Display ]
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Fant 4 e
i Isolate 4
i Layer...
P Crphans
= Package
Pour b
Rank, 4
‘4 Ratio... o h
0,3045
g Shees 04084
N e i’ 0.6096
,  Cpacng b 08125
Stop b 1.016
£ Skyle 4 1.97 ~
£ Technology 1,424 F4
Text
Thermals  # B
Via i 1,778
1.9304 =
2.1844
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3.61 —

£.4516




Display Skyle

Valg mm.
) on %) Off ) Dots (%) Lines
Mulkiple: |1

5] [ ]

Der er nu mulighed for at Route, dvs. erstatte gummibandene med kobberbaner. Det kan ggres
manuelt, eller Eagle kan ggre det automatisk. (

Fgr autorouting og manuel routing, kan der indstilles default banebredde. Valg
Edit > Design Rules > Sizes.

10 mill er 0,25 mm bred bane. 40 mill er 1 mm.
Saet Minimum Width til 40 mill eller bedre 60 mill.

Se evt. converter pa http://www.unitconversion.org/length/millimeters-to-mils-conversion.html

. ' ﬁ 1 Top TE
Velg Autorouting. =~ 17op ([~

Automatisk routing er default sat til dobbeltsidet
layout, men det kan slas fra nar autorouting er
valgt. Valg N/A for top layer. 16 Bottom || v

Fgr der autoroutes, bgr man opsatte nogle regler for, hvordan man gnsker sin printplade lavet.
default settings er 8 mil (8 mil = 8/1000 inch= 0.2 mm).
Edit > Design Rules:

Vealg:




Clearence Wire
Wire |1.5mm | Pad
o Pad |32mi NE= | Via
via | 3zmil || 3zl | | 3zmi
Same Signals
Smd Pad Yia
— f——
Size ( banebredde
Minimum Width | &0mil
Mirirurn Dl | 24mil
Min. Micra ia |9.99mm
Min, Blind Via Ratio | 0.5
Restring ?? Min % Max  Di
Pads Top [2ami |25 [20mi
Inner [1omi |25 | 20mi |
Bottom | 24mil |25 | 40mi
Vias Outer | 24mil F5 | 40l
Inner  [8mil |25 | 20mi |
Micro Vias Outer | 4mi |25 | 20mid
Inner | 4mi |25 | 20mi
Shapes for ger: Min % Max
Roundness  [0md fo | omi
Shape
O e =]
Bottom {Round =
First |Round =]
Elongation % | 100 100

Klik evt. pa click x (ratsnest) for at se, hvor mange baner, der ikke blev autoroutet.

For at Rippe op i baner, ( Ga bagl®ns ) klikkes pa .%- (ripup) tool. Klik de baner, der skal Unroutes,
eller l (go) button. Herved vil alle baner unroutes. ( Laves til rubberband igen. )




Manuel routing.

S

Vha knapperne — | kan der hhv. Routes, og unroutes. Dvs. Ga tilbage til elastikband.

Er der behov for at springe over en bane,
placeres en Via, og der routes videre pa top-

layer, til en ny Via.
- 00

En via velges med

Banebredde ?? Option > Set > Misc. Tjek ”Autoset route width and drill ???7?

Banebredde kan @ndres, Hgjreklik > properties.

Tekst:
Hvis man blot trykker T, for Text, legges teksten I Cobberlaget ”
bottom.
Enter texk:

Nar teksten er tastet ind, og der tastes OK, valges i toppen [ |
hvilket lag, der skal skrives.:

. I K l ’ Cancel ]
21 tPlace er top silketryklaget. ??

[ 21 tPlace vange:n | |

o' [[B|B see 1778 v |Ratio

8 % V|ant:|PerDrtiDnaI V|

Beskyttet omrade:.

I 42 bRestrict = ) .
I layer i = J b = Buttom. kan der evt. tegnes en cirkel om et omrade, hvor der
ikke ma leegges baner. Fx pga. monteringshuller i printet.




Tips:

Flyt flere komponenter og baner samtidig:

Copy:

Fejltjeck:

Printudlaegs-tips:

For at flytte en komponent med dets ledninger, skal man ferst
grupere delene med "Group” for at veelge de dele, man gnsker at
flytte. Derefter veelges veerktajet “Move”. Herefter hgjreklikkes pa
det valgte for at flytte delene. Venstreklik vil kun flytte valgte
komponent, ikke hele det gruperede !!

At kopiere et areal er lidt meerkelig. Ferst bruges “group” for at
veelge et omrdde. Herefter bruges "cut”, Hajreklik pd det valgte
areal, for at kopiere og endelig "Paste”

Husk at udfere et erc check ved at klikke pa “erc" knappen. Herefter
forteeller Eagle om der er ledninger, der ikke er forbundne. Der
fremkommer ngjagtige x,y-kordinater for problemet.

2) Here are a couple of the tools for the board. Most of the schematic tricks
listed above will work for the board as well.

The first thing to be familiar with is the "display” tool. This is a very
helpful tool. It makes the view of the board less crowed on the
screen. When you click this button, it brings up another window that
shows all the different things that can be viewed. Use the left
column to highlight/un-highlight what you would like to view. Any
item with a "t" in front of it stands for top of the board, while "b"
stands for bottom of the board.

After organizing the board with the dimensions and parts, the next
step is to auto route the board. Click the "auto” button to bring up



the autoroute window. A good idea is to keep the routing grid
between 5-10 mils. Just click go and it will begin. The percentage it
completes will be displayed on the status bar located on the bottom
of the screen.

- If the auto router does not complete, then you will need o move
some parts around a little then try again. Firsts you must remove the
traces it created to re-route it again. Click the "ripup” tool then click
the "go" tool located on the top tool bar (looks like a traffic light).
Then click ok.

Tutorial: http://www.sparkfun.com/commerce/tutorial info.php?tutorials id=57

http://mvyhome.spu.edu/bolding/EE4211/EagleTutorial4.htm

Download Biblioteker: http://www.cadsoft.de/cgi-
bin/download.pl?page=/home/cadsoft/html public/download.htm.deé&dir=eagle/userfiles/libraries&
sort=time

ftp://ftp.cadsoft.de/eagle/userfiles/libraries

http://www filesearching.com/cgi-bin/s ?t=n&l=en&q=ftp.cadsoft.de/pub/userfiles/libraries

Dok downloadable fra Cadsoft
http://www.cadsoft.de/cgi-
bin/download.pl?page=/home/cadsoft/html public/download.htm.en&dir=pub/userfiles/doc




